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Assessment Instructions 

Task overview 

Task overview 

This is assessment three (3) of three (3) assessments for BSBTEC402 Design and produce complex 
spreadsheets. 

This is an open book written assessment. You can use your learning materials as a reference.  

The following assessment tasks use a simulated business called Complete Business 
Solutions Australia (CBSA). To complete the assessment tasks, you will need to access 
the information, documents and templates associated with CBSA that were previously 
provided or developed in Assessment 2. Additional resources and supporting documents 
are attached along with your assessment in the LMS.   

For this assessment, students will play the role of Robyn Willis, the Junior Accountant 
for CBSA. CBSA is a consultancy service business that provides compliance, financial, 

human resources and information technology support, and other business services to ensure that businesses 
have the expertise and support they need to be competitive and prosper. 

You must complete all tasks and their parts correctly to achieve a satisfactory outcome for this assessment. 

Additional supporting documents and resources 

To complete this assessment, you will need the following supporting documents: 

Task 1 

– Style Guide (retained from Assessment 2 Task 2) 

– Budgeted Planning Project Financial Data (retained from Assessment 2 Task 2) 

– Email Template (retained from Assessment 2 Task 2) 

– Budgeted Planning Template (retained from Assessment 2 Task 2) 

– Budgeted v Actual Planning Template (retained from Assessment 2 Task 2) 

Task 2 

– Financial Data October          

– Excel spreadsheets and graphs developed in Task 1 

You will also need the following resources: 

– Access to learning materials on the learning portal 

– Access to a computer, the internet and email 

– Access to a suitable simulated computer workstation environment 

– Access to Microsoft Excel 

– Access to Ms Teams or Zoom 

 
IMPORTANT: This assessment must be undertaken after Assessment 2 Task 2 as it directly relates to the 
production of the two spreadsheet documents as prepared and planned during Assessment 2 Task 2. 
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   Please consider the environment before printing this assessment.  

Assessment Information 

Submission 

You are entitled to three (3) attempts to complete this assessment satisfactorily. Incomplete assessments will 
not be marked and will count as one of your three attempts.  

All questions must be responded to correctly to be assessed as satisfactory for this assessment. 

Answers must be typed into the space provided and submitted electronically via the LMS. Hand-written 
assessments will not be accepted unless previously arranged with your assessor. 

Reasonable adjustment  

Students may request a reasonable adjustment for assessment tasks.   

Reasonable adjustment usually involves varying:  

– the processes for conducting the assessment (e.g. allowing additional time)  
– the evidence gathering techniques (e.g. oral rather than written questioning, use of a scribe, 

modifications to equipment)  

However, the evidence collected must allow the student to demonstrate all requirements of the unit.  

Refer to the Student Handbook or contact your Trainer for further information. 
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Submission requirements    
  
To be eligible to be deemed competent in this assessment, you are required to complete and submit the 
following documents.  
 

Task 1 

– Email to Gavin Stead (Managing Director) CBSA with the following documents attached: 
 Budgeted spreadsheet - July – September  
 Budget vs Actual spreadsheet - July – September  
 Graph showing budgeted versus actual revenue for July, August and September.  
 Graph showing budgeted versus actual expense for July, August and September.  
 Graph showing budgeted versus actual net position for July, August and September  

Task 2 

– Email to Mary Lee (Finance Manager) CBSA with the following documents attached: 

 Budgeted spreadsheet - July – October  
 Budget vs Actual spreadsheet - July – October  
 Graph showing budgeted versus actual revenue for July, August, September and October 
 Graph showing budgeted versus actual expense for July, August, September and October 
 Graph showing budgeted versus actual net position for July, August, September and October 
 CBSA Budgeted v Actual Financial Data report   
 video recording demonstrating how to import and export data into the management report. how 

to create and run the automation (macro), how to access help functions to solve spreadsheet 
problems and how to name and save the files. 
 

Please save any Word documents as PDF files before submitting.   
 
Most modern web browsers can open and display a PDF file. However, if you have an older operating system, 
you may need a PDF reader installed on your device, such as the Acrobat Reader, available from Adobe.   
  
Windows: Word 2013 and newer   
Choose File > Export > Create PDF/XPS.   
  
Windows: Word 2010   
1. Click the File tab   
2. Click Save As. To see the Save As dialogue box in Word 2013 and Word 2016, you have to choose a location and 

folder   
3. In the File Name box, enter a name for the file, if you haven't already   
4. In the Save as type list, click PDF (*.pdf).   

If you want the file to open in the selected format after saving, select the Open file after publishing 
check box.   
If the document requires high print quality, click Standard (publishing online and printing).   
If the file size is more important than print quality, click Minimum size (publishing online).   

5. Click Options to set the page to be printed, to choose whether markup should be printed, and to select output 
options. Click OK when finished.   

6. Click Save.   
  
macOS: Office for Mac   
To save your file as a PDF in Office for Mac, follow these easy steps:   
1. Click the File   
2. Click Save As   
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3. Click File Format towards the bottom of the window   
4. Select PDF from the list of available file formats   
5. Give your file a name if it doesn't already have one, then click Export   
  
For more detailed instructions, refer to Microsoft Support.  
 

 

 

 

Task 1 

Task Summary 

For this assessment task, you are required to develop two complex spreadsheets. 

Resources and Equipment Required 

– Access to learning materials on the learning portal 
– Access to a computer, the internet and email 
– Access to a suitable simulated computer workstation environment 
– Access to Microsoft Excel 
– Style Guide (retained from Assessment 2 Task 2) 

– Budgeted Planning Project Financial Data (retained from Assessment 2 Task 2) 

– Email Template (retained from Assessment 2 Task 2) 

– Budgeted Planning Template (retained from Assessment 2 Task 2) 

– Budgeted v Actual Planning Template (retained from Assessment 2 Task 2) 

 

To complete this assessment task, you must read the following email and then complete the tasks that follow. 

 To: 
 Robyn Willis (robyn.willis@cbsa.com.au) 

From: Gavin Stead (gavin.stead@cbsa.com.au) 

Date/time: Thursday 15 Jan 20XX 11:35 a.m. 

Subject: Budget Spreadsheet Development 

 
  

Good morning, Robyn 

 

Thank you for putting together such comprehensive plans for spreadsheet development. I am 
impressed with the quality of your work.  

I am very keen to have these two (2) complex spreadsheet documents (listed below) developed as 
soon as possible. Ideally, I would like them developed within a two-week timeframe. Therefore, 
please start work on these spreadsheets straight away:  

1. Budgeted 

2. Budgeted vs Actual.  
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Once you have developed the two (2) spreadsheets, ensure you email them to me directly, as I must 
view these documents as soon as possible.  

On another note, it’s been great to see you working with our finance team, and I hope to plan 
additional projects with the assistance of yourself and Mary Lee soon.  

Thanks again for your assistance on this project, and I look forward to hearing from you.  

 

Kind Regards, 

Gavin Stead 

Managing Director - CBSA 

300 Fictional Way, Sydney, NSW 2000 

Phone: 1800 111 222 

www.cbsa.com.au 

 

Task 1 Student Instructions 

You are required to assume the role of Robyn Willis, the Junior Accountant at CBSA and produce the two 
complex spreadsheets as prepared and planned during Assessment 2 Task 2.  

 

To successfully complete this task, you must undertake the following steps: 

1. Carefully read the email from Gavin Stead and ensure you have retained all required documents from 
Assessment 2 Task 2. These documents are as follows:  

 Style Guide  

 Project Financial Data (retained from Assessment 2 Task 2)  

 Budgeted Planning Template (filled in and retained from Assessment 2 Task 2) 

 Budgeted v Actual Planning Template (filled in and retained from Assessment 2 Task 2) 

 Email Template. 

 

These documents will provide you with the financial data and specific spreadsheet specifications and 
requirements to develop the two complex spreadsheets. Therefore, refer to these documents constantly 
while developing the following complex spreadsheets:  

 Budgeted 

 Budgeted vs Actual. 

Access and use Microsoft Excel to produce two spreadsheets and create a linked solution as per the 
spreadsheet planning templates (plans).  

 Budgeted Planning Template (filled in and retained from Assessment 2 Task 2) 

 Budgeted v Actual Planning Template (completed and retained from Assessment 2 Task 2). 

 

Note: The two spreadsheets can be created in a single Excel workbook.  

 

Access Project Financial Data (retained from Assessment 2 Task 2) and enter the data into the excel 
workbook. The workbook must clearly indicate three (3) worksheets (Budgeted, Actual, Actual vs Budgeted). 
A ‘linked’ sheet/solution must be evident across the workbook. 

http://www.cbsa.com.au/
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2. Apply software design functions and formulae to the worksheets as per spreadsheet templates (plans) and 
the CBSA Style Guide.  

 

3. In the workbook, format cells and use data attributes assigned with cell references as per spreadsheet 
templates (plans).  

 

4. In the workbook, ensure all calculated data is accurate by testing all formulae and confirming that output is 
correct with formulas linked across worksheets. Again, compete for this step as per templates (plans).  

 

5. Create the three graphs using spreadsheet data as per template (plan) for CBSA Projected Budget Vs Actual.  

Follow planned graph style (bar chart) to meet requirements as per template (plan).  

All graphs must have labels and titles from numerical data contained within the spreadsheet file. 

The three graphs that must be created are as follows: 

 Graph showing budgeted v actual revenue for July, August and September. 

 Graph showing budgeted v actual expense for July, August and September. 

 Graph showing budgeted v actual net position for July, August and September. 

 

6. Once you have developed the spreadsheet's name and store the two spreadsheets as identified on 
templates (plans). 

 

7. Compose an email to Gavin Stead – Managing Director (assessor), providing a summary of the email's 
purpose and attaching the two developed complex spreadsheets and the three graphs. Use the email 
template provided in Assessment 2 for this purpose.  

Your email must cover the following points:  

 a brief description summarising the purpose of the email  

 description of the email attachments: 

o Budgeted spreadsheet 

o Budgeted vs Actual spreadsheet 

o Graph showing budgeted v actual revenue for July, August and September. 

o Graph showing budgeted v actual expense for July, August and September. 

o Graph showing budgeted v actual net position for July, August and September. 

 timeframe by which you developed the two complex spreadsheets 

 your name and position title. 

 

8. Lastly, exit the software application (Microsoft Excel) without any loss of data. 

 

Assessment 3 Task 1 Assessor Guide 

Purpose of the Task 

This part is designed to ensure students can demonstrate the ability to develop two complex 
spreadsheet documents. Students are provided with the opportunity to develop a linked spreadsheet 
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solution, apply software design functions and formulas, format cells/ data attributes, test the accuracy 
of formulas, create graphs to meet numerical information requirements and exit software applications.  

 

Guidance to Assessors About this Task 

This task must be undertaken after the student has completed Assessment 2 Task 2, as the student will 
now draw on all the information gathered concerning spreadsheet specifications and requirements. The 
student must retain the following documents from Assessment 2 Task 2:  

 Style Guide - BSBTEC402_02_Project_Style Guide_220210 

 Project Financial Data - BSBTEC402_02_Project_Financial Data_220204  

 Budgeted Planning Template - BSBTEC402_02_Project_Budgeted Planning 
Template_220204 (filled in) 

 Budgeted v Actual Planning Template - BSBTEC402_02_Project_Budgeted v Actual 
Planning Template_220204 (completed and retained from Assessment 2 Task 2) 

 Email Template - BSBTEC402_02_Project_Email Template_220204 

These documents will provide the student with the financial data and specific spreadsheet 
specifications and requirements to develop the two complex spreadsheets. Students must refer to 
these documents constantly while developing the following required spreadsheets: 

 Budgeted 

 Budgeted vs Actual. 

The assessment begins with an email from Gavin Stead (Managing Director) CBSA to the student playing 
the role of Robyn Willis (Junior Accountant) CBSA in relation to the development of two complex 
spreadsheet documents. Please read the email below to familiarise yourself with the required 
background knowledge.  

 

Good morning, Robyn 

Thank you for putting together such comprehensive plans for spreadsheet development. I am 
impressed with the quality of your work.  

I am very keen to have these two complex spreadsheet documents developed as soon as possible. 
Ideally, I would like them developed within a two-week timeframe. Therefore, please start work on 
these spreadsheets straight away:  

1. Budgeted 

2. Budgeted vs Actual.  

Once you have developed the two spreadsheets, ensure you email them to me directly, as I must 
view these documents as soon as possible.  

On another note, it’s been great to see you working with our finance team, and I hope to plan 
additional projects with the assistance of yourself and Mary Lee soon.  

Thanks again for your assistance on this project, and I look forward to hearing from you.  

 

Kind Regards, 

Gavin Stead 

 

The student must produce the two complex spreadsheets prepared and planned during Assessment 2 
Task 2.  
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To successfully complete this task, students must undertake the following steps: 

1. The student must carefully read the email from Gavin Stead and ensure they have retained all 
required documents from Assessment 2 Task 2. These documents are as follows:  

 Style Guide - BSBTEC402_02_Project_Style Guide_220210 

 Project Financial Data - BSBTEC402_02_Project_Financial Data_220204  

 Budgeted Planning Template - BSBTEC402_02_Project_Budgeted Planning 
Template_220204 (filled in) 

 Budgeted v Actual Planning Template - BSBTEC402_02_Project_Budgeted v Actual 
Planning Template_220204 (completed and retained from Assessment 2 Task 2) 

 Email Template - BSBTEC402_02_Project_Email Template_220204 

As stated above, these documents will now provide students with the financial data and specific 
spreadsheet specifications and requirements to develop the two complex spreadsheets. Therefore, 
students must refer to these documents constantly while developing the following two (2) complex 
spreadsheets:  

 Budgeted: This spreadsheet must specify CBSA’s budgeted revenue and 
expenditure.  

 Budgeted vs Actual: This spreadsheet must specify CBSA’s budgeted revenue and 
expenditure compared to the actual revenue and expenditure. Graphs must be 
created as part of the spreadsheet output. Refer to point 7 for further detail.  

 

2. The student must use a blank Microsoft Excel workbook to generate the two spreadsheets and 
three graphs and create a linked solution as per spreadsheet templates (plans). The spreadsheets 
and graphs can be created in a single Excel workbook. The workbook must clearly indicate three (3)  
worksheets (Budgeted, Actual and Actual vs Budgeted). A ‘linked’ sheet/solution must be evident 
across the workbooks.  

The student must enter manual data correctly from Project Financial Data - 
BSBTEC402_02_Project_Financial Data_220204 document. Evidence of this includes figures and 
totals, which are accurate.  

Please refer to BSBTEC402_03_Project_ Budget & Variance Analysis Assessor Guide A3 T1 as this 
workbook provides a benchmark answer.  

 

3. The student must apply software design functions and formulae to the excel worksheets as stated 
in the specific spreadsheet templates (plans), including the use of Style Guide - 
BSBTEC402_02_Project_Style Guide_220210 as follows:  

Software Design  

 all Financial Totals are to be Bold  

 red font/ shading must be applied to any negative values 

 - sign must be applied to all negative values 

 all $ amounts must include the $ symbol, use 1000 separator (,) and two (2) decimal 
places 

 Top and Double Bottom Border style must be used for all grand totals  

 all content is to be left-aligned in each cell except for: 

o title headings which can be centred and bolded 

o numbers that are to be right-aligned 
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 the students must use CBSA’s Style Guide in relation to colour themes or select a 
similar/ complementary colour of their personal choice.  

 the student must be consistent in their use and application of colour themes. 

 the student must arrange data logically, for example, all revenue items, followed by 
expense items and then net position.  

Readability 

The student must use design principles to improve presentation and readability. For example:  

 white space to improve readability 

 shading alternate rows to improve readability 

 the need to use grid lines sparingly and not place too much emphasis on the individual 
cell 

 the need to remove gridlines/ background lines as these can be a distraction to the user.  

Applying formulae 

The student must apply formulae in specific spreadsheet templates (plans), including ‘AutoSum’ 
and/ or addition formula to total figures. The use of a minus calculation/ function to calculate net 
position. The student may also use conditional formatting functions to highlight net position 
negative values etc.  

 

Please refer to BSBTEC402_Assessor Guide_Project_Budget & Variance Analysis T1_220225 as this 
workbook provides a benchmark answer.  

 

4. In the workbook, the student must format cells and use data attributes assigned with cell 
references as per spreadsheet templates (plans) 

 The student must express all figures in currency terms by adding the dollar ($) symbol to 
these cells amending data attributes.  

 The student can use Wrap Text (if needed) to ensure readability. 

 The student must ensure all headings are aligned in the same consistent manner.  

 The student must ensure all figures are aligned in a consistent and meaningful way that 
is easy to read. 

 The student must ensure cell references are clear.  

 

5. In the workbook, the student must ensure all calculated data is accurate by testing all formulas and 
confirming that the output is correct. Again, the student must complete this step as per templates 
(plans). 

 The student’s formulas must be correct, and there is to be evidence that the student has 
tested formulas before finalising spreadsheets. For example, formulas are accurate and 
linked across sheets without error.  

 The student’s mathematical formulas must meet the needs of the two spreadsheets in 
that you can clearly see totals (revenue, expenses) and net position and ‘variance 
analysis’ etc.  

 The student formula references are accurate as assigned to cells.  

 

6. The student must create the three graphs using spreadsheet data as per the template (plan) for 
CBSA’s Budgeted vs Actual. The student must follow the planned graph style (bar chart) to meet 
requirements as per the template (plan).  
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All graphs produced by students must have labels and titles from numerical data contained within 
the spreadsheet file. 

The three graphs that students must create are as follows: 

 Graph showing budgeted v actual revenue for July, August and September. 

 Graph showing budgeted v actual expense for July, August and September. 

 Graph showing budgeted v actual net position for July, August and September. 

For example: 

 The student must create the three bar charts as indicated above.  

 The student must use planned styles such as chart type and colour theme.  

 The student must use apply design function as stated in specific spreadsheet templates 
(plans), including the use of Style Guide - BSBTEC402_02_Project_Style Guide_220210 as 
follows: 

 

 The student must label all graphs by giving each graph a title and relevant labels such 
as Monthly Revenue/ Income Jul, Aug, and Sep.  

 The student must link each graph to numerical data within the spreadsheet file, i.e. 
budgeted amounts are linked back to the ‘budgeted’ sheet.  

 

7. Once developed, the student must name and store the two spreadsheets as identified on templates 
(plans).  

For example, the student has named each document as per templates (plans) and provided a 
version number, i.e., CBSA Budgeted V Actual Version 1. Evidence of this includes file names as 
attached to the Email to Gavin Stead.  

 

8. The student must compose an email to Gavin Stead – Managing Director (assessor), providing a 
summary of the email's purpose and attaching the two (2) developed complex spreadsheets and 
three graphs. The students must use the email template provided in Assessment 2 Task 2.  

The student’s email must cover the following points:  

 A brief description summarising the purpose of the email, for example, “I am writing to 
advise that I have now developed the two complex spreadsheet documents. Please find 
these documents attached”.  

 The two (2) complex spreadsheets and three graphs are completed and attached to the 
email: 

o Budgeted spreadsheet 

o Budgeted vs Actual spreadsheet 

o Graph showing budgeted v actual revenue for July, August and September. 
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o Graph showing budgeted v actual expense for July, August and September. 

o Graph showing budgeted v actual net position for July, August and September 

 Timeframe by which the student developed the two complex spreadsheets. For 
example, “I have completed this task within the required two-week timeframe”.  

 Student name and position title. For example, Robyn Willis (Junior Accountant) CBSA. 

 

9. Finally, the student must exit the software application (Microsoft Excel) without any loss of data.  

The student must send the spreadsheet documents via email without losing any data and closing 
the application correctly. Evidence of this includes complete and workable/functional files 
submitted via email.  

 

*Note to assessor: please refer to B BSBTEC402_Assessor Guide_Project_Budget & Variance 
Analysis T1_220225 to assess students' work as this workbook provides suggested responses.  

 

 
 

 
 

 

 

 

 

Task 2 

Task Summary 

For this assessment task, you are required to use multiple complex spreadsheets to import and export data 
across spreadsheets and create an automated spreadsheet operation. 

Resources and Equipment Required 

 Access to learning materials on the learning portal 

 Access to a computer, the internet and email 

 Access to a suitable simulated computer workstation environment 

 Access to Microsoft Excel 

 Access to MS Teams or Zoom 

 Style Guide (retained from Assessment 2 Task 1) 

 Two spreadsheets and three graphs that were developed in Assessment 3 Task 1 
 Budgeted spreadsheet (Completed)  
 Budgeted vs Actual spreadsheet (Completed)  
 Graph showing Budgeted v Actual Revenue for July, August and September. 
 Graph showing Budgeted v Actual Expense for July, August and September. 
 Graph showing Budgeted v Actual Net Position for July, August and September. 

 Financial Data October  

 Email Template (retained from Assessment 2 Task 1) 
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Important: This assessment task must be undertaken after Assessment 3 Task 1 as it directly relates to using 
the two complex spreadsheets developed in Task 1. 

To complete this assessment, you must read the following email and then complete the tasks that follow. 

 To: Robyn Willis (robyn.willis@cbsa.com.au) 

From: Gavin Stead (gavin.stead@cbsa.com.au) 

Date/time: Monday 19 Jan 20XX 09:05 a.m. 

Subject: CBSA – Budget Reporting. 

File Attached: Financial Data October 

Good morning, Robyn, 

I am writing to thank you for all your efforts in developing the required spreadsheets. I am impressed 
with your work.  

The Budgeted spreadsheet specified budgeted revenue and expenditure.  

The Budgeted v Actual spreadsheet indicated budgeted compared to the actual revenue and 
expenditure.  

The graphs you created were both meaningful and useful for decision-making purposes. Well done!  

Since developing the above spreadsheets, we now have access to our October financial data, which I 
have attached. Therefore, I ask that you update the two spreadsheets and graphs developed to 
include figures for October. Note: I have provided the October financial data in an MS Excel format so 
that you can import it into your spreadsheets.  

Once the above is complete, I ask that you export the October financial data to generate one report 
in a new workbook/spreadsheet. This report will be used by management and must include the 
following data: 

 Actual and Budgeted Revenue for each department for October 

 Actual and Budgeted Expenses for each department for October 

 Actual and Budgeted Net Position for October 

Please be advised that management have specific report formatting needs that must be met. 
Therefore, you must create an automated function (macro) to ensure you meet these needs. 
Formatting needs are as follows: 

 ensure all figures are in currency (dollars $) 

 apply a Filter to columns 

 use Conditional Formatting to: 

 revenue: highlight any figures less than $300,000 

 expenses: highlight any figures greater than $50,000.  

 change all font to Calibri size 12 

 format the header rows to a light blue colour 

 bold all headings  

 create a command button to run the macro. 

I would like you also to create a video recording (10-15 minutes in length) for Mary Lee (Finance 
Manager), documenting the step-by-step process on how you: 

 imported and exported the data  



ASSESSOR GUIDE  BSBTEC402 Design and Produce Complex Spreadsheets 

  Page 13 of 25 

 developed, use and edit the automation (macro) 

 access help and save and store the document. 

This is important as Mary Lee will need to generate this report in the future, and therefore, she needs 
to have a sound understanding of how to complete these processes.  

Once you have done this, please provide Mary Lee with a copy of the video and the following three (3) 
complex spreadsheets by saving them into a file on your desktop titled CBSA Financial Data Reports 
and emailing the file to her. 

 Budgeted spreadsheet, including October figures 

 Budgeted vs Actual spreadsheet, including October figures 

 Graphs including October figures 

 CBSA Budgeted v Actual Financial Data report - Revenue, Expenses and Net Position for 
October. 

 

I thank you for your assistance.  

Kind Regards, 

Gavin Stead 

Managing Director 

300 Fictional Way, Sydney, NSW 2000 

Phone: 1800 111 222 

www.cbsa.com.au 

 

 

Task 2 Student Instructions 

 

You are required to use multiple spreadsheets to import and export data across spreadsheets and create an 
automated spreadsheet operation. You will also be required to produce a recording that demonstrates how 
you: 

 Create, use and edit a macro  

 Import and export data between compatible spreadsheets and adjust as needed 

 Access and use the help function to solve spreadsheet problems 

 Name and store documents. 

 

 Task Instructions 

To successfully complete this task, you must undertake the following steps: 

 

Update and use spreadsheets 

1. Carefully read the email from Gavin Stead and then download the following document as outlined in the 
email. 

 Financial Data October 

 

http://www.cbsa.com.au/
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2. Ensure you have retained the completed spreadsheets and graphs from Assessment 3 Task 1, as you will be 
updating these documents. The documents to be retained are: 

 Budgeted spreadsheet (Completed)  

 Budgeted vs Actual spreadsheet (Completed)  

 Graph showing Budgeted v Actual Revenue for July, August and September 

 Graph showing Budgeted v Actual Expense for July, August and September 

 Graph showing Budgeted v Actual Net Position for July, August and September. 

 

Now that you have read the Gavin Stead email and have access to the above three documents, you are 
ready to use and update your complex spreadsheets. 

 

3. You must update the documents retained from Assessment 3 Task 1 to include CBSA’s Financial Data for 
October as provided to you in Gavin Stead's email. October figures have been provided to you in a 
compatible spreadsheet so that you can demonstrate your ability to import data.  

 Financial Data October   

To do this, import CBSA’s Financial Data for October to update the two (2) spreadsheet documents 
completed and retained from Assessment 3 Task 1 and the three graphs: 

 Budgeted spreadsheet  

 Budgeted vs Actual spreadsheet 

 

Now that you have updated the above budget documents to include financial data from October, you will create 
the spreadsheet budget report. 

 

Create and use a spreadsheet report 

4. You must export information/data for October (only) from the updated saved spreadsheets (above) into a 
new workbook/spreadsheet to demonstrate your ability to export data. The financial data you must be 
exported is: 

 Actual and Budgeted Revenue for each department for October 

 Actual and Budgeted Expenses for each department for October 

 Actual and Budgeted Net Position for October. 

Note: To ensure consistency of data and layout requirements, follow the same design and layout as previously 
completed budget spreadsheets when formatting the report, i.e. Revenue followed by Expenses followed by Net 
Position.  Ensure all calculated data is accurate by testing all formulae and confirming that output is correct 
with formulas linked across worksheets. 

 

Once you have exported October financial data from your updated spreadsheet(s) into a new 
workbook/spreadsheet, you are ready to use and reformat your now created CBSA Budgeted v Actual Financial 
Data report to meet management’s reporting needs. 

 

5. Now that you have a new workbook/spreadsheet in which you have exported the required financial data 
relating to October, you must further develop the CBSA Budgeted v Actual Financial Data report for 
management.  

Management has specific requirements in relation to formatting the report. As this report will be generated 
frequently, you must create an automated function (macro) to meet reporting needs. 
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Management has stated that automation (macro) must include the following formatting actions. Therefore, 
you must create a macro that automates the following steps:  

 ensure all figures are in currency (dollars $) 

 apply a Filter to columns 

 use Conditional Formatting to: 

 revenue: highlight any figures less than $300,000.  

 expenses: highlight any figures greater than $50,000 

 change all font to Calibri size 12 

 format the header rows to a light blue colour (your choice) 

 bold all headings  

 create a command button to run the macro. 

To do this, you must use the Microsoft Excel help function as needed. These help functions are available 
online.  

 

Save the Reports 

6. Once you have completed all the above tasks, pdf and save the following three (3) spreadsheets and three 
(3) graphs to a file on your desktop titled CBSA Financial Data Reports: 

Spreadsheets 

 Budgeted (including July to October figures) 

 Budgeted vs Actual (including July to October figures) 

 CBSA Budgeted v Actual Financial Data Report for October (generated from the above 
spreadsheets). 

Graphs 

 Graph - Budgeted v Actual Revenue (including July to October figures) 

 Graph - Budgeted v Actual Expense (including July to October figures) 

 Graph - Budgeted v Actual Net Position (including July to October figures). 

 

 

Recording the Process (in Ms Teams or Zoom) 

2. Mary Lee (Finance Manager CBSA) is going on annual leave the day after tomorrow. She will be away for 1 
week and she would need to generate this exact report in the near future. 

Create a training video (10 to 15 minutes in length) for her that demonstrates the process for performing 
the following tasks using spreadsheets: 

 Import data between compatible spreadsheets and adjust as needed. 

 Export data between compatible spreadsheets and adjust as needed. 

 Create, use and edit a macro to meet the requirements of the CBSA Budgeted v Actual Financial 
Data report.  

 Access help functions to solve spreadsheet problems 

 Naming and saving the files.  

 

To record the training video. Following these steps: 

• Open Microsoft Teams (or Zoom) and go to the Calendar tab. 
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• Schedule a meeting by clicking on "New Meeting" and entering the details for your training session. 
You can keep it as a private meeting for yourself. 

• Join the Meeting at the scheduled time. As you didn’t invite anyone, you’ll be the only person in the 
meeting. 

• Once you're in the meeting, make sure your camera and microphone are set up correctly.  

• In the meeting controls, click on the three dots (More Actions) at the top of the screen to open 
additional options. Select Start Recording from the menu. Teams will notify you that the recording has 
started. 

• At the beginning of the training video, you must introduce yourself stating your name, and the role you 
are playing in the training video, then summarise what are you going to demonstrate in the video (as it is 
outlined in the task instructions). For example: “My name is XY and in this video I am playing the role of 
Robyn Willis, the Junior Accountant at CBSA. In this video I am going to demonstrate the following: (…)”   
During this introductory part, the camera must clearly show your face. 

• Once you have introduced yourself and the purpose of the video, share your screen by clicking on the 
Share button (an arrow icon pointing upward) and choose the screen or window you want to share. 

• Talk through the five (5) tasks you are demonstrating (as it is outlined in task instructions and in the 
following checklist), including demonstrating where to save the spreadsheets on your computer. 

• Once you finish the demonstration, stop sharing your screen and conclude the training. You may offer 
Mary Lee to contact you if she needs further help. 

• When you're finished, click the three dots (More Actions) menu again and select Stop Recording from 
the options. Teams will end the recording and process it in the background. 

• Go to the chat for the meeting, where the recording will appear once it's processed. This typically takes 
a few minutes depending on the length of your video. 

• Download the video as an mp4 file. 

 

Video recording evidence checklist and submission requirements  

During the recording, your assessor will be looking to see that you have demonstrated: 

 

 Introductory part showing the student’s face 

 

 Consistency of data entered spreadsheet 

 

 How to import data between compatible spreadsheets, check for accuracy and 
adjust to meet requirements. 

 

 How to export data between compatible spreadsheets and adjust to meet 
requirements.  

 

 How to create, use and edit a macro (automation) to meet task requirements.  

 

  How to access help functions to solve spreadsheet problems.  

 

 How to name, save and exit the spreadsheets according to organisational and 
task requirements. 

 

 

☐ 

 

☐ 

 

☐ 

 

 

☐ 

 

☐ 

 

☐ 

 

 

☐ 

 

☐ 
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 The training video is no longer than 15 minutes. 

 

 

After you have recorded the process, email Mary Lee a copy of the recording and a copy of each of the 
following three complex spreadsheets and graphs: 

 Budgeted, including October figures 

 Budget vs Actual, including October figures 

 CBSA Budgeted v Actual Financial Data report for October (generated from the above spreadsheets) 

 Graph - Budgeted v Actual Revenue (July to October) 

 Graph - Budgeted v Actual Expense (July to October) 

 Graph - Budgeted v Actual Net Position (July to October) 

 

Use the email template provided in Assessment 2 Task 2 to write the email, listing the required files’ names 
as attachments, then submit the files on LMS together with the documents required for Task 1. 

 

Assessment 3 Task 2 Assessor Guide 

Purpose of the task 

This part is designed to ensure students can demonstrate the ability to use and update two complex 
spreadsheet documents and produce and use one complex spreadsheet for reporting purposes. The 
students are provided with the opportunity to identify and develop automation (macros) and import and 
export spreadsheet data.  

Reassessment arrangements  

Where students do not correctly or adequately demonstrate the skills and knowledge required for this 
task, they will need to be given feedback. Depending on the level of their performance and the types of 
areas in which they did not show competence, you may request that they undertake further learning 
and redo the task again. 

Guidance to assessors about this task 

This task must be undertaken after the student has completed Assessment 3 Task 1, as the student will 
use the two complex spreadsheets developed to complete the required updates. Spreadsheet 
documents to be retained from Assessment 3 Task 1 are: 

 Budgeted spreadsheet (Completed)  

 Budget vs Actual spreadsheet (Completed).  

The assessment begins with an email from Gavin Stead (Managing Director) CBSA to the student playing 
the role of Robyn Willis (Junior Accountant) CBSA in relation to updating the two complex spreadsheet 
documents as developed (Assessment 3 Task 1) and generating one (1) report for management. Please 
read the email below to familiarise yourself with the required background knowledge.  

 
 

Good morning, Robyn, 

I am writing to thank you for all your efforts in developing the required spreadsheets. I am impressed 
with your work.  

The Budgeted spreadsheet specified budgeted revenue and expenditure.  
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The Budgeted v Actual spreadsheet indicated budgeted compared to the actual revenue and 
expenditure.  

The graphs you created were both meaningful and useful for decision-making purposes. Well done!  

Since developing the above spreadsheets, we now have access to our October financial data, which I 
have attached. Therefore, I ask that you update the two spreadsheets and graphs developed to include 
figures for October. Note: I have provided the October financial data in an MS Excel format so that you 
can import it into your spreadsheets.  

Once the above is complete, I ask that you export the October financial data to generate one report in a 
new workbook/spreadsheet. This report will be used by management and must include the following 
data: 

 Actual and Budgeted Revenue for each department for October 

 Actual and Budgeted Expenses for each department for October 

 Actual and Budgeted Net Position for October 

Please be advised that management have specific report formatting needs that must be met. 
Therefore, you must create an automated function (macro) to ensure you meet these needs. Formatting 
needs are as follows: 

 ensure all figures are in currency (dollars $) 

 apply a Filter to columns 

 use Conditional Formatting to: 

 revenue: highlight any figures less than $300,000 

 expenses: highlight any figures greater than $50,000.  

 change all font to Calibri size 12 

 format the header rows to a light blue colour 

 bold all headings  

 create a command button to run the macro. 

I would like you to also create a video for Mary Lee (Finance Manager), documenting the step-by-step 
process on how you: 

 imported and exported the data  

 developed the automation (macro). 

This is important as Mary Lee will need to generate this report in the future, and therefore, she needs to 
have a sound understanding of how to complete these processes.  

Once you have done this, please provide Mary Lee with a copy of the video and the following three (3) 
complex spreadsheets by saving them into a file on your desktop titled CBSA Financial Data Reports and 
emailing the file to her. 

 Budgeted spreadsheet, including October figures 

 Budgeted vs Actual spreadsheet, including October figures 

 Graphs including October figures 

 CBSA Budgeted v Actual Financial Data report - Revenue, Expenses and Net Position for 
October. 

 

Thank you for your assistance.  

Kind Regards, 

Gavin Stead 
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1. The student must read the email from Gavin Stead and then download the following document as outlined 
in the email. 

 Financial Data October - BSBTEC402 _03_Project_Financial Data October_220201   

The purpose of this document is to provide students with CBSA’s Financial Data for the month of October. 
Financial data has been provided in an MS Excel format to provide students with the opportunity to import 
data. 

 

2. The student must retain the completed spreadsheets and graphs from Assessment 3 Task 1 as they will 
need to update these documents for this assessment task. The documents to be retained are: 

 Budgeted spreadsheet (Completed)  

 Budgeted vs Actual spreadsheet (Completed)  

 Graph showing Budgeted v Actual Revenue for July, August and September 

 Graph showing Budgeted v Actual Expense for July, August and September 

 Graph showing Budgeted v Actual Net Position for July, August and September. 

 

3. The student must update the documents retained from Assessment 3 Task 1 to include CBSA’s Financial 
Data for October (as provided in the email from Gavin Stead). The October figures have been provided to the 
student in a compatible spreadsheet so that they can demonstrate their ability to import data and adjust 
documents according to software and organisational requirements.  

Therefore, students must update the two spreadsheet documents and three graphs as completed and 
retained from Assessment 3 Task 1: 

 Budgeted (Completed) must be updated by the student to include October financial data.  

 Budgeted v Actual (Completed) must be updated by the student to include October financial data. 

 Graph showing Budgeted v Actual Revenue for July, August and September must be updated to 
include October financial data 

 Graph showing Budgeted v Actual Expense for July, August and September must be updated to 
include October financial data 

 Graph showing Budgeted v Actual Net Position for July, August and September must be updated to 
include October financial data 

 

The student’s formulas must be correct, and there must be evidence that the student has tested formulas 
before finalising spreadsheets. For example, the student has identified the intentional addition error 
(Expenses $888,183.34, should be $778,833.34) and corrected it. The formulae must be linked across sheets 
without error.  

  

Please refer to BSBTEC402_Assessor Guide_Project_Budget & Variance Analysis T2_220225 as this workbook 
provides a benchmark answer.  

 

Create and use a spreadsheet budget report 

4. The student must export information/data for the month of October (only) from the updated Budgeted vs 
Actual spreadsheet into a new workbook/spreadsheet as they are required to demonstrate their ability to 
export data. Financial data which must be exported includes: 

 Actual and Budgeted Revenue for each department for October 

 Actual and Budgeted Expenses for each department for October 

 Actual and Budgeted Net Position for October 
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The students must demonstrate that they have followed the same design and layout as previously 
completed budgeted and budgeted v actual spreadsheets when formatting the report, i.e. Revenue 
followed by Expenses followed by Net Position. Please refer to BSBTEC402_Assessor Guide_Project_Budget & 
Variance Analysis T2 Macro_220225 as this workbook provides a benchmark answer.  

Once the student has exported the October financial data from their updated spreadsheet(s) into a new 
workbook/spreadsheet, they must use and reformat the data to create CBSA Budgeted v Actual Financial 
Data Report for October to meet management’s reporting needs. 

 

5. Once the student has produced a new workbook/spreadsheet into which they have exported the required 
financial data relating to the month of October, they must further develop the report for management. 
Management has specific requirements in formatting the report. As this report is to be generated 
frequently, students must create an automated function (macro) to meet reporting needs. 

Management has stated that automation (macro) must include the following. Therefore, students must 
create a macro that automates the following steps:  

 ensure all figures are in currency (dollars $) 

 apply a Filter to columns 

 use Conditional Formatting to: 

 revenue: highlight any figures less than $300,000 

 expenses: highlight any figures greater than $50,000.  

 change all font to Calibri size 12 

 format the header rows to a light blue colour 

 bold all headings  

 create a command button to run the macro. 

 

Please refer to point seven (7.) below as this provides a benchmark answer which includes the steps the 
student must complete to create a macro.  

 

Students use the Microsoft Excel help function as needed. These help functions are available online.  

 

Save the Reports 

6. Once the student has completed all the above tasks, they must generate the following three spreadsheets 
and graphs: 

 Budgeted, including October figures  

 Budgeted vs Actual, including October figures 

 CBSA Budgeted v Actual Financial Data report for October (generated from the above spreadsheets) 

 Graph - Budgeted v Actual Revenue, including October figures 

 Graph - Budgeted v Actual Expense, including October figures 

 Graph - Budgeted v Actual Net Position, including October figures. 

 

Documenting the Process 
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7. The student must create a video recording for Mary Lee (Finance Manager), who will need to generate this 
report in the future.  

The recording must demonstrate the process for performing the following tasks using spreadsheets: 

 Import data between compatible spreadsheets and adjust as needed. 

 Export data between compatible spreadsheets and adjust as needed. 

 Create, use and edit a macro to meet the requirements of the CBSA Budgeted v Actual Financial 
Data report.  

 Access help functions to solve spreadsheet problems 

 Naming and saving the files  

Mary Lee will need to generate this report in the future, and therefore, she needs to have a sound 
understanding of how to complete these processes.   

 

Video recording evidence checklist and submission requirements for assessor  

The student's video recording must demonstrate how to:  

Introductory part showing the student’s face 

To ensuring academic integrity, the student must show their face at the beginning of 
the recording, introduce themselves, explain the role they are playing and summarise 
the purpose of the training video.  For example: “My name is XY and in this video I am 
playing the role of Robyn Willis, the Junior Accountant at CBSA. In this video I am going 
to demonstrate the following: (…)” 

☐ 

Consistency of data entered spreadsheet 

The student must demonstrate they developed, edited, and used templates consistently 
and uniformly and as per CBSA’s requirements and those specifications as originally set 
out in Assessment 2 Task 2.  

Note: These requirements relate to the design and layout of the Budgeted, Budgeted v 
Actual spreadsheet: as created during Assessment 3 Task 1. The student must continue 
to use the same style (CBSA’s Style Guide) and template (plans) format when updating 
the two complex spreadsheet documents and creating the management report. 
However, please note that the report also contains formatting outlined in the macros to 
meet management’s reporting requirements. 

 

☐ 

Import data between compatible spreadsheets, check for accuracy and adjust as 
needed 

This must include importing data from a separate spreadsheet (Financial Data October - 
BSBTEC402 _03_Project_Financial Data October_220201). For example: 

 The student selected Data and then selected Import External Data and Import 
Data. Then, the student selected the MS Excel file that they wished to import 
data from.  

 The student imported data as needed into the complex spreadsheet documents, 
i.e., data from CBSA’s Financial Data October to the Budgeted v Actual 
spreadsheet, therefore adding October figures to the correct worksheet.  

The student must check data to ensure accuracy by checking over formulas. For example, 
formulas can be checked via: 

  the Show Formulas option on the Excel ribbon 

 

 

☐ 

 

 

 

 

 

 

 

☐ 
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 hovering over a cell can also display its formula  

Therefore, checking over the various automated actions to ensure that they are correct. 

The student must demonstrate how they adjust data if needed to ensure accuracy. For 
example: 

 formulas can be checked via the Show Formulas option on the Excel ribbon.  

 hovering over a cell can also display its formula 

therefore, checking over the various automated actions to ensure they are correct. 

 

 

 

 

 

☐ 

Export data between compatible spreadsheets and adjust as needed 

This must include: 

Exporting data from a spreadsheet to a separate spreadsheet/ new workbook. For example: 

 the student selected the worksheet they wished to export (move) and then, 
using a Right-Click, opened a ‘pop-up’ menu and selected Move or Copy. Once 
the Move or Copy dialogue box was open, the student selected to move the 
sheet to a new workbook. The student created a copy and placed 
information/data into the new workbook.  

Adjusting data if needed to ensure accuracy. For example: 

 formulas can be checked via the Show Formulas option on the Excel ribbon. 
Hovering over a cell can also display its formula. Therefore, checking over the 
various automated actions to ensure that they are correct. 

 

 

 

 

☐ 

 

 

 

 

☐ 

Create, use and edit a macro to meet the requirements of the budget 
report  

To achieve the above, the student must locate the Developer Tab, which is hidden by 
default, and enable it. Then, the student must select Record a Macro and give the Macro 
a name (Name Box) and a description (Description Box). Once this is complete, the 
student must select OK to start recording the macro (Record Macro. The following 
formatting steps/ actions must be automated and therefore included in the macro by the 
student: 

 figures are in currency (dollars $) 

 Filter applied to all columns  

 Conditional Formatting is used to: 

o highlight any revenue figures less than $300,000 

o highlight any expense figures greater than $50,000.  

 all font is Calibri size 12 

 the header rows formatted to a light blue colour 

 all headings have been bolded 

After all the actions to be automated have been performed, the student must select Stop 
Recording (Developer Tab). 

The student must then use the Visual Basic Editor to view the actions they recorded as 
specified in ‘code’, checking over the various automated actions to ensure that they are 
correct and identifying and correcting any errors identified.  

 

Source: Support.microsoft.com. 2022. Quick start: Create a macro. [online] Available at: 
<https://support.microsoft.com/en-us/office/quick-start-create-a-macro-741130ca-080d-
49f5-9471-1e5fb3d581a8> [Accessed 14 February 2022]. 

 

 

 

 

☐ 

 

 

 

 

 

 

 

 

 

 

☐ 
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The student must also create a macro button to run the macro. 

To do this, the student must: 

  locate the Developer tab in the Controls group 

  click Insert 

  select Button under From Controls 

 click anywhere in the worksheet. This will open the Assign Macro dialogue box 

 select the macro they want to assign to the button, and click OK. 

 name the button 

Source:  Support.microsoft.com. 2022. Quick start: Create a macro. [online] Available at: 
<https://support.microsoft.com/en-us/office/quick-start-create-a-macro-741130ca-080d-
49f5-9471-1e5fb3d581a8> [Accessed 14 February 2022]. 

 

 

 

☐ 

Access and use the help function to solve spreadsheet problems 

The student must access Microsoft help online to assist with advanced spreadsheet 
functions.  

This could include help with:  

• locating the Developer Tab 

• creating a macro 

• editing a macro with Visual Basic Editor 

• creating a macro button 

• importing data 

• exporting data 

 

☐ 

Name, save and exit the documents. 

The student must demonstrate how they name, save and exit an excel document. For 
example: 

 the student clicked File and then save 

 the student clicked/ browsed a folder. The student then typed a name for the 
document in the File name box, for example, CBSA Budgeted v Actual Financial 
Data Report for October and then clicked Save. 

Exit. For example: 

 after saving the spreadsheet documents, the student exited the application (as 
above).  

 the student clicked the file tab and then clicked Close.  

 

☐ 

The training video is no longer than 15 minutes ☐ 

 

After the student has recorded the process, they must email Mary Lee a copy of the recording and a copy of 
each of the following three complex spreadsheets and graphs: 

 Two (2) updated complex spreadsheets completed with CBSA’s October Financial Data: 

o Budgeted (including July – October data) 
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o Budgeted v Actual (including July – October data) 

 One (1) CBSA Budgeted v Actual Financial Data Report for October (management report), as 
generated from the above spreadsheets. 

 Three (3) graphs: 

o Graph - Budgeted v Actual Revenue (including July to October figures) 

o Graph - Budgeted v Actual Expense (including July to October figures) 

o Graph - Budgeted v Actual Net Position (including July to October figures). 

 

Email to Mary Lee – Finance Manager CBSA (assessor), as per provided template. Must include: 
A brief description summarising the purpose of the email, for example,  

 
“I am writing to inform you that I have now finalised the development of the spreadsheet 
documents, graphs and management report. I have attached for your perusal: 

Two (2) updated complex spreadsheets completed with CBSA’s October Financial Data: 

o Budgeted (including July – October data) 

o Budgeted v Actual (including July – October data) 

One (1) CBSA Budgeted v Actual Financial Data Report for October (management report), as 
generated from the above spreadsheets. 

Three (3) graphs: 

o Graph - Budgeted v Actual Revenue (including July to October figures) 

o Graph - Budgeted v Actual Expense (including July to October figures) 

o Graph - Budgeted v Actual Net Position (including July to October figures). 

 
I have also attached a video documenting the step-by-step process so that you can generate these 
reports in the future”.  
 
 

The student's name and position title: For example, Robyn Willis (Junior Accountant) CBSA.  

 

 

Note to assessor: please refer to  

 BSBTEC402_Assessor Guide_Project_Budget & Variance Analysis T2 _220225 

 BSBTEC402_Assessor Guide_Project_Budget & Variance Analysis T2 Macro_220225 

to assess the student's work as these workbooks, provide suggested responses.  
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Assessment checklist:  

Students must have completed all tasks within this assessment before submitting. This includes: 
 

1 

Email to Gavin Stead (Managing Director) CBSA with the following documents attached: 

 Budgeted spreadsheet - July – September  
 Budget vs Actual spreadsheet - July – September  
 Graph showing budgeted versus actual revenue for July, August and 

September 
 Graph showing budgeted versus actual expense for July, August and 

September 
 Graph showing budgeted versus actual net position for July, August and 

September  

☐ 

☐ 

☐ 

☐ 

☐ 

☐ 

2 

Email to Mary Lee (Finance Manager) CBSA with the following documents attached: 

 Budgeted spreadsheet - July – October  
 Budget vs Actual spreadsheet - July – October  
 Graph showing budgeted versus actual revenue for July, August, September 

and October 
 Graph showing budgeted versus actual expense for July, August, September 

and October 
 Graph showing budgeted versus actual net position for July, August, 

September and October 
 CBSA Budgeted v Actual Financial Data report   
 Training video recording covering all requirements.  

 

☐ 

 

☐ 

☐ 

☐ 

☐ 

☐ 

☐ 

☐ 

☐ 

 
 

 

              

 Congratulations, you have reached the end of Assessment 3! 
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